
    
CodeWarrior ®

QuickStart Professional

Because of last-minute changes to CodeWarrior, 
some of the information in this manual may be 

inaccurate. Please read the Release Notes on the 
CodeWarrior CD for the latest up-to-date information.

Revised: 98/03/02 map



                   
Metrowerks CodeWarrior copyright ©1993–1998 by Metrowerks Inc. and its licensors. 
All rights reserved.
Documentation stored on the compact disk(s) may be printed by licensee for personal 
use. Except for the foregoing, no part of this documentation may be reproduced or trans-
mitted in any form by any means, electronic or mechanical, including photocopying, 
recording, or any information storage and retrieval system, without permission in 
writing from Metrowerks Inc.
Metrowerks, the Metrowerks logo, CodeWarrior, and Software at Work are registered 
trademarks of Metrowerks Inc. PowerPlant and PowerPlant Constructor are trademarks 
of Metrowerks Inc.
All other trademarks and registered trademarks are the property of their respective 
owners.
ALL SOFTWARE AND DOCUMENTATION ON THE COMPACT DISK(S) ARE SUB-
JECT TO THE LICENSE AGREEMENT IN THE CD BOOKLET.

How to Contact Metrowerks:

U.S.A. and international Metrowerks Corporation
P.O. Box 334
Austin, TX  78758
U.S.A.

Canada Metrowerks Inc.
1500 du College, Suite 300
Ville St-Laurent, QC
Canada  H4L 5G6

Ordering Voice: (800) 377–5416
Fax: (512) 873–4901

World Wide Web http://www.metrowerks.com

Registration information register@metrowerks.com

Technical support support@metrowerks.com

Sales, marketing, & licensing sales@metrowerks.com

CompuServe goto Metrowerks



             
Table of Contents
1 Welcome 7

CodeWarrior Reference Web Site  .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 7
Get Started, Quick!  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 8
About this Book   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 9
Registering CodeWarrior    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   11
What’s New  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   11
What You Should Know .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   12

2 Overview 13
The CodeWarrior IDE .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   13
Multiple Programming Hosts    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   15
Multiple Languages .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   15
Multiple Programming Targets .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   16
Libraries and Application Frameworks   .   .   .   .   .   .   .   .   .   .   .   17
CodeWarrior Documentation.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   18

3 Installing CodeWarrior on Windows 21
Windows System Requirements    .   .   .   .   .   .   .   .   .   .   .   .   .   .   21
Before You Install on Windows .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   22
Installation Overview on Windows  .   .   .   .   .   .   .   .   .   .   .   .   .   23
Installation Procedure on Windows  .   .   .   .   .   .   .   .   .   .   .   .   .   24
What’s Installed on Windows    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   27

4 Installing CodeWarrior on Mac OS 29
Mac OS System Requirements   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   29
Before You Install on Mac OS .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   30
Installation Overview on Mac OS .   .   .   .   .   .   .   .   .   .   .   .   .   .   31
Installation Procedure on Mac OS .   .   .   .   .   .   .   .   .   .   .   .   .   .   32
What’s Installed on Mac OS   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   34

5 A Quick Tour of CodeWarrior 35
Guided Tour Overview   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   35
Launching the CodeWarrior IDE  .   .   .   .   .   .   .   .   .   .   .   .   .   .   36
Setting IDE Preferences   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   36

Opening the Preferences Dialog Box   .   .   .   .   .   .   .   .   .   .   .   36
QuickStart Professional   QSP–3



     
Viewing and Setting Options in Preference Panel .   .   .   .   .   .   38
Closing the Preferences Dialog Box .   .   .   .   .   .   .   .   .   .   .   .   38

Opening a CodeWarrior Project.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   39
Using the Project Window  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   39

View Tabs .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   40
Toolbar  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   40
Toolbar Tooltips   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   41
Project Window Columns  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   41
Groups  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   42
Interface Pop-ups    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   43
Context Pop-ups .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   43

Using the CodeWarrior Editor   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   44
Creating a New Text File    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   44
Opening a File .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   44
Entering Text into a File .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   45
Saving Changes to a File    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   46

Setting Target Options.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   46
Opening the Target Settings Dialog Box  .   .   .   .   .   .   .   .   .   .   47
Viewing and Setting Options in a Settings Panel   .   .   .   .   .   .   47
Closing the Target Settings Dialog Box    .   .   .   .   .   .   .   .   .   .   47

Building Projects with CodeWarrior .   .   .   .   .   .   .   .   .   .   .   .   .   48
Updating a Project  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   48
Making a Project  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   48
Running a Project    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   48
Debugging a Project   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   49
Building a Program.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   49

Where to Go From Here  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   50

6 Using CodeWarrior 51
Learning to Use CodeWarrior    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   51
Online Help  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   53
Web Sites of Interest.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   53
Additional Reference Material   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   54
Getting Updates and Patches .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   55
Shortcuts   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   55
QSP–4   QuickStart Professional 



      
7 Metrowerks Support 57
Contacting Metrowerks  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   57
Registration and Updates   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   57
Technical Support.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   58
Sales, Renewals, and Site Licensing  .   .   .   .   .   .   .   .   .   .   .   .   .   59
Worldwide Distributors  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   59
Metrowerks Store .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   63

8 Software License 65
QuickStart Professional   QSP–5



  
QSP–6   QuickStart Professional 



             
1
Welcome
Welcome to CodeWarrior Professional from Metrowerks, the flexi-
ble, powerful, easy to use programming package for Microsoft® 
Windows®, Mac® OS, and Java™. Use CodeWarrior Professional 
on Windows or Mac OS to write software in C, C++, Pascal, or Java 
to run on Windows, Mac OS, or Java VM.

Whether you’re brand new to programming or an experienced pro-
grammer getting your first taste of CodeWarrior, we want your pro-
gramming experience to be a good one. Read this guide to introduce 
yourself to and get started using CodeWarrior Professional.

Getting started

If you can’t wait to dive in and get started using CodeWarrior, see 
“Get Started, Quick!” on page 8.

What’s in this book

To find out what’s in this book, see “About this Book” on page 9.

Getting help

Got a problem you can’t solve? If you run into a problem while try-
ing to use CodeWarrior that isn’t covered in this book or any other 
CodeWarrior documentation, see “Metrowerks Support” on 
page 57 for information on contacting Metrowerks for technical and 
customer support.

CodeWarrior Reference Web Site
CodeWarrior Professional comes with an entire Web site on your 
computer to guide you through the tutorials, documentation, and 
on-line books included with your CodeWarrior software. 
QuickStart Professional   QSP–7



 

Welcome

 

Get Started, Quick!

                   
Windows

To access the CodeWarrior Reference Web Site under Windows:

1. Click the Start button in the Taskbar.

2. Navigate to the Metrowerks CodeWarrior item, which is installed 
in the Programs sub-menu by default.

3. Choose CodeWarrior Reference Web Site.

Mac OS

To access the CodeWarrior Reference Web Site under Mac OS:

1. Locate and open the Metrowerks folder on your hard disk.

2. Double-click the Reference Web Site icon in the Metrowerks 
folder.

NOTE: The CodeWarrior Reference Web Site uses specific fea-
tures found in Microsoft Internet Explorer. Although you may use 
other Web browser applications to view the site, Metrowerks rec-
ommends Internet Explorer to take full advantage of the Refer-
ence Web site. If you are using a browser other than Internet Ex-
plorer make sure it is set up to use Adobe Acrobat to open “.PDF” 
files.

Get Started, Quick!
The quickest way to learn what Metrowerks CodeWarrior is all 
about is to follow the steps below.

1. Read the software license.

Please read the “Software License” on page 65 and make sure you 
understand and agree with it before installing your new software.

2. Register CodeWarrior.

Make sure you’ve registered your software to receive free technical 
support and any free or discounted updates you might be entitled 
to. See “Registering CodeWarrior” on page 11 for more information.
QSP–8   QuickStart Professional 



 

Welcome

 

About this Book

                 
3. Introduce yourself to CodeWarrior.

See “Overview” on page 13 to learn about using the different parts 
of CodeWarrior to develop software.

4. Install CodeWarrior.

To install your new software on your computer, follow the direc-
tions for your computer system: 

• see “Installing CodeWarrior on Windows” on page 21 to in-
stall CodeWarrior for the Windows platform.

• see “Installing CodeWarrior on Mac OS” on page 29 to install 
CodeWarrior for the Mac OS platform.

5. Take a tour of the CodeWarrior IDE.

Turn to “A Quick Tour of CodeWarrior” on page 35 for a short, 
step-by-step exploration of the CodeWarrior IDE (Integrated Devel-
opment Environment), the center of CodeWarrior software develop-
ment.

6. Learn about the rest of CodeWarrior.

See “Using CodeWarrior” on page 51 to learn and find more infor-
mation about other features of  CodeWarrior.

About this Book
This QuickStart Professional book covers:

• what’s in the CodeWarrior Professional software package

• how to install CodeWarrior Professional

• a brief introduction to the CodeWarrior IDE (Integrated De-
velopment Environment), the center of CodeWarrior soft-
ware development

• where to find more information on using CodeWarrior

• getting technical and customer support from Metrowerks

The chapters in QuickStart Professional cover the topics shown in 
Table 1.1.
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Table 1.1 Chapters in this book and the topics they cover

This chapter… covers these topics

“Welcome” on page 7 introduction to this book, the 
CodeWarrior Reference Web 
Site, getting started, eligibility 
for free and discounted updates, 
what’s new, what you should 
know before using CodeWarrior 

“Overview” on page 13 programming tools, host plat-
forms, programming languages, 
target platforms, application 
frameworks, introduction to 
documentation and example 
projects 

“Installing CodeWarrior on 
Windows” on page 21

system requirements and steps 
for installing CodeWarrior Pro-
fessional on Microsoft Windows

“Installing CodeWarrior on 
Mac OS” on page 29

system requirements and steps 
for installing CodeWarrior Pro-
fessional on Mac OS

“A Quick Tour of CodeWar-
rior” on page 35

brief introduction to the 
CodeWarrior IDE, the center of 
CodeWarrior software develop-
ment

“Using CodeWarrior” on 
page 51

getting and applying updates, 
references to other information 
on using CodeWarrior

“Metrowerks Support” on 
page 57

contacting Metrowerks and its 
distributors for technical sup-
port, customer support, and 
other services

“Software License” on page 65 the conditions to using this soft-
ware
QSP–10   QuickStart Professional 



 

Welcome

 

Registering CodeWarrior

              
Registering CodeWarrior
Did you just buy this software?

If this is the first time you’ve purchased CodeWarrior, pull out your 
registration card now, fill it out, and send it to Metrowerks to re-
ceive free technical support. Your registration card will also tell you 
if this product qualifies for free updates. 

See “Registration and Updates” on page 57 for details on registering 
your new Metrowerks product.

Is this your last update?

If this is your last product update, read “Registration and Updates” 
on page 57 for information about further updates so you can con-
tinue to receive the latest CodeWarrior tools.

What’s New
To find out what’s new with CodeWarrior Professional, see:

• What’s New release note

The What’s New release note is located in the top directory of 
the CodeWarrior CD-ROM. It contains a broad overview of 
the major changes offered in this release of CodeWarrior.

• Release Notes  folder

The Release Notes  folder on the CD contains detailed re-
lease notes for the software in this product. 

• Metrowerks documentation

Finally, many of the Metrowerks documentation manuals 
contain a What’s New section describing new features.
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What You Should Know
To get the most out of this software, you should be familiar with op-
erating your computer, using the mouse, menus, buttons, windows, 
clicking, dragging, and so on. If you’re not familiar with these terms 
or the actions associated with them, please refer to the instructions 
in the user’s guide or the on-line help system that come with your 
computer.
QSP–12   QuickStart Professional 



       
2
Overview
This chapter introduces you to the Metrowerks CodeWarrior devel-
opment universe. With CodeWarrior, no programming project is 
out of your reach. The overview covers the following  topics:

• The CodeWarrior IDE

• Multiple Programming Hosts

• Multiple Languages

• Multiple Programming Targets

• Libraries and Application Frameworks

• CodeWarrior Documentation

• Example Projects

The CodeWarrior IDE
The CodeWarrior IDE (Integrated Development Environment) is 
the center of CodeWarrior software development. The IDE offers:

• Power – From the IDE you can edit, browse, compile, link, 
and run your project. The IDE includes a text editor, class 
browser, and a project manager to help you do all your pro-
gramming tasks easily and quickly. 

• Flexibility – Plug-in compilers and linkers support many dif-
ferent platforms and processors. The same powerful IDE is 
used to develop and generate software for such targets as 
Win32®/Intel, Mac OS®, MIPS™, Motorola® 680x0, and 
PowerPC™.

• Convenience – The IDE running both on Windows as well as 
Mac OS are based on the same technology. Because the IDE 
and its plug-ins operate identically for all platforms, devel-
opers who program on multiple platforms save time and ef-
fort using the familiar CodeWarrior tools for all their 
projects. 
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The IDE’s core tools are the tightly and transparently integrated pri-
mary components used to write code. Table 2.1 describes some of 
the individual components included with the CodeWarrior IDE.

Table 2.1 The IDE’s core tools

This tool… Provides these features and functions

project manager Use the commands in the IDE’s Project menu to gather all the 
files of a program together along with configurable sets of 
options into a project file, and decides for you which plugin 
compilers and linkers to act on the project to create the final 
program.

source code editor Use the commands in the Edit and Search menus, and the 
controls in the IDE’s editor windows to edit source code and 
text. Some of the editor’s features are:

• edit, search, and replace text in one file or several files

• split an editor window into multiple panes

• toggle between a source file and its related interface 
file

• open an interface file referred to by a source file

• set markers at arbitrary locations in a text file

• jump to any routine in any file instantly

• customize the source code display

browser Use the commands in the Window menu, features in any 
source code view, and controls in the browser’s window to 
get quick, intuitive access to the definitions of classes, vari-
ables, routines, enumerations, and other source code ele-
ments.
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Some Metrowerks products do not include support for all available 
core tools. See the documentation to determine which core tools are 
included in your package.

Multiple Programming Hosts
Metrowerks CodeWarrior is currently hosted on these platforms:

• Windows 95 or Windows NT

• Mac OS (68K or PowerPC)

• BeOS

This makes it easy to switch to another platform as your program-
ming requirements change while retaining the familiar CodeWar-
rior development environment.

Multiple Languages
CodeWarrior Professional supports development with the most 
common languages used by professional programmers today: C, 
C++, Java, and Pascal. Table 2.2 shows the list of compilers Metrow-
erks provides to generate software for its target platforms.

compilers and linkers Thanks to its plugin architecture, the IDE is able to play host 
to a limitless variety of compilers and linkers to generate soft-
ware for several operating system and processor platforms. 

debugger Use the commands in the Window, Debug, and Data menus 
to control your program, step through its source code or as-
sembly statements, set breakpoints, set watchpoints, and ex-
amine its data while it executes. The IDE’s debugger works 
with all kinds of code in all the supported languages—C, 
C++, Pascal, and Java. Use the debugger to debug libraries, 
executables, multiple threads, and processes. The debugger 
also supports debugging code running on multiple proces-
sors.

This tool… Provides these features and functions
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Table 2.2 Language supported for targets

Some Metrowerks products do not include support for all available 
languages. See the documentation to determine which language(s) 
are included in your package.

Multiple Programming Targets
Use CodeWarrior on your host system to write software for many 
operating system and processor platforms (targets). Table 2.3 shows 
you some of the major targets supported by each host.

Table 2.3 Programming targets and their host development platforms

Target platform C C++ Java Pascal

BeOS • • •

Java Virtual Machine •

Mac OS 
(68K and PowerPC)

• • • •

Palm OS • •

Sony PlayStation or 
Net Yaroze

• •

Win32/Intel • • • •

Target platform Windows Mac OS BeOS

BeOS •

Java Virtual Machine • • •

Mac OS (68K & PPC) • •

Palm OS • •
QSP–16   QuickStart Professional 



 

Overview

 

Libraries and Application Frameworks

         
The CodeWarrior product you purchased does not include compil-
ers and linkers for every possible target. Check the documentation 
for a list of targets supported by the product.

Libraries and Application Frameworks
Standard libraries

Metrowerks includes standard libraries with its compilers, when 
appropriate for a target platform. CodeWarrior Professional in-
cludes MSL (Metrowerks Standard Library) for C and C++ for 
Win32/Intel and Mac OS. MSL C and MSL C++ are ANSI-conform-
ant standard libraries. For Pascal, Metrowerks supplies “built-in” 
routines to conform to ANS Pascal, Turbo Pascal, and MPW Pascal.

Target libraries

To access the services and features of a target platform’s operating 
system, Metrowerks also includes libraries and interface files from 
the target platform’s manufacturer. For example, CodeWarrior Pro-
fessional comes with Microsoft’s Win32 SDK header files to develop 
software for the Win32/Intel platform.

Application frameworks

Programming for modern, graphical operating systems like 
Mac OS, Windows 95/NT, and Java is non-trivial, and that’s where 
an application framework helps. A framework supplies standard-
ized code to handle many  common programming tasks, making the 
creation and design of a new application much easier and faster. 

The CodeWarrior comes with several complete application frame-
works, one for each major CodeWarrior target. 

Sony PlayStation or 
Net Yaroze

• •

Win32/Intel • •

Target platform Windows Mac OS BeOS
QuickStart Professional   QSP–17
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Table 2.4 Frameworks supported

CodeWarrior Documentation
Metrowerks CodeWarrior comes with a wealth of online documen-
tation. This is found in the CodeWarrior Documentation  folder 
on the CodeWarrior Professional Reference CD-ROM or through 
the CodeWarrior Reference Web Site installed on your computer’s 
hard drive. For more information on using documentation to learn 
about CodeWarrior, see “Using CodeWarrior” on page 51.

Finding information for a specific target platform

To learn the use CodeWarrior to develop software for a particular 
target platform, refer to the appropriate Targeting  manual that 
comes with CodeWarrior Professional. For example,  to learn  and 
develop an application or DLL for Win32/Intel using CodeWarrior, 
read Targeting Win32.

Every Targeting manual has the following:

•  a description of the tools  you’ll use to develop software for     
the target platform it covers 

• a tutorial 

• steps to configure different kinds of projects for the platform 

• relevant libraries and other useful information

Getting printed documentation

Some manuals titled Inside CodeWarrior  are available as printed 
books. Contact your local distributor or browse the Metrowerks 
Web page (http://www.metrowerks.com ) for information .

Framework Target platform

AWT (Abstract Windowing Toolkit) Java

MFC (Microsoft Foundation Classes) Windows

PowerPlant Mac OS
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Example Projects

CodeWarrior Professional comes with lots of sample source code 
and projects to give you an insight into how others use CodeWar-
rior to develop software. You’ll find this sample software in the 
CodeWarrior Examples  folder on the CodeWarrior Professional 
Reference CD-ROM.
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3
Installing 
CodeWarrior on 
Windows
This chapter explains the installation procedure for  the CodeWar-
rior Professional software package on PCs running Microsoft® Win-
dows®. The topics in this chapter are:

• Windows System Requirements

• Before You Install on Windows

• Installation Procedure on Windows

• What’s Installed on Windows

Windows System Requirements
Metrowerks CodeWarrior requires the following hardware and 
software:

Table 3.1 Windows Requirements

Hardware Intel Pentium-class processor (recommended), or 
80486-class processor, 16 megabytes of RAM, CD-
ROM drive

Software Windows NT 4.0 or greater (recommended) or Win-
dows 95 or later

Other 120 MB free hard disk space (minimum install)
QuickStart Professional   QSP–21
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Before You Install on Windows
Before installing the software on your Windows computer, you 
should:

1. Read the Metrowerks Software License.

Make sure you understand and agree with the “Software License” 
on page 65 before installing the software.

2. Make sure your software package is complete.

This software package should contain:

1. QuickStart Professional guide (optional on some products and 
updates)

2. A CodeWarrior Professional Windows Tools CD

3. A CodeWarrior Professional Reference CD

4. A registration card (optional on some products and updates)

5. Geekware catalog

NOTE: If any of these items are missing, contact your local dis-
tributor or Metrowerks sales (sales@metrowerks.com ). See 
“Metrowerks Support” on page 57 for more information.

3. Make sure your computer system meets the specified hardware 
and software requirements.

See “Windows System Requirements” on page 21.

4. Quit all running applications before installing.

To avoid installation problems, it is highly recommended that you 
quit all running applications before launching the CodeWarrior in-
stallation software.

WARNING! Be sure to turn off all virus protection software be-
fore running the installation software.
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Installation Overview on Windows
The installation software on the CodeWarrior Professional Win-
dows Tools CD-ROM installs all the necessary components you will 
need to use CodeWarrior. The installation software presents the op-
tions listed in Table 3.2.

Table 3.2 Installation types for Windows

This option… Installs these items on your hard disk

CodeWarrior 
Heaven

all CodeWarrior development tools, compil-
ers, linkers, libraries, and help files for all tar-
get platforms

Target Heaven the tools, compilers, linkers, libraries, and 
help files for only the target platforms you 
choose

Custom only the components you choose
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Figure 3.1 Metrowerks installation options

Installation Procedure on Windows
To install CodeWarrior Professional on a Windows computer:

1. Back up and remove previous versions of CodeWarrior.

The installation software on CodeWarrior Professional can’t suc-
cessfully install a new version of CodeWarrior if an older version of 
CodeWarrior already exists on your computer. To remove the old 
version of CodeWarrior, launch the Uninstall CodeWarrior pro-
gram. This program is available from the Start menu.

2. Launch the CodeWarrior installation program.

Insert the CodeWarrior Professional Windows Tools CD-ROM into your 
CD-ROM drive.

If the Auto Insert Notification setting for your CD-ROM drive is en-
abled, a dialog box will appear automatically when the CD is in-
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serted or when you double-click the CD icon. Click Launch 
CodeWarrior Setup to begin installing CodeWarrior.

Alternatively, double-click the CD icon, then double-click the file 
named Setup.exe  in the CD’s top folder to begin installing 
CodeWarrior.

In a moment a window will appear, welcoming you to CodeWarrior 
Setup. Click Next to continue to the software license.

TIP: You can click Cancel anytime during the setup process to 
stop the installation and exit the installation program.

3. Read the software license.

When the software license appears, please read it. If you agree, click 
Next to continue to choose the installation type.

4. Choose your installation type.

See “Installation Overview on Windows” on page 23 for a descrip-
tion of the options in the setup window. Click Next to continue to 
choose the destination to install the CodeWarrior software.

5. Select a destination for the files.

Choose location to install CodeWarrior on your hard disk. To accept 
the default location, just click Next to continue.

To change the location, click Browse to display a dialog box 
prompting you for a directory. Choose a new destination directory, 
click OK, then click Next to continue.

6. Choose your installation components (Custom and Target Heaven 
installation types only).

If you choose Custom or Target Heaven in step 4. then select the 
components you’d like to install on your computer’s hard disk. 
Click Next to continue.

7. Select a folder in the Shortcut menu.

Choose the folder in the Shortcut menu that will display the 
CodeWarrior shortcuts as they’ll appear in the Start menu, then 
click Next.
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8. Review your choices.

Review all your installation choices. If you aren’t satisfied, use the 
Back button to make changes. Otherwise, click Next to start the in-
stall operation. This might take several minutes.

9. After installation, read the release notes.

After installation, please read the file “What’s New” for the latest re-
lease information, and refer to the Release  Notes  directory for ad-
ditional release details.

10. Install CodeWarrior documentation and examples.

Repeat steps 1 through 8 using the CodeWarrior Professional Reference 
CD to install the CodeWarrior documentation, programming exam-
ples, third-party books, and other programming goodies.

TIP: Some of the documentation on the Reference CD exists in 
uncompressed format to allow direct viewing on the CD.

11. Install Microsoft Internet Explorer.

Microsoft Internet Explorer (MSIE) is required to fully access the 
CodeWarrior Reference Web Site. Although you may use other Web 
browser applications, Internet Explorer employs the features of the 
Reference Web site to its fullest capabilities. If you are using a 
browser other than Internet Explorer make sure it is set up to use 
Adobe Acrobat to open “.PDF” files.

If you don’t already have MSIE on your hard disk, installation soft-
ware is in the Doc Viewers  directory on the CodeWarrior Profes-
sional Windows Tools CD.

12. Install Adobe Acrobat.

To read documents in the Reference Web Site, you must have 
Adobe Acrobat Reader installed on your hard disk. The Adobe Ac-
robat installation software is available in the root directory on the 
CodeWarrior Professional Windows Tools CD. Open the Acrobat 
Reader  directory in the Doc Viewers  directory and double-click 
the executable file to install Acrobat Reader.
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What’s Installed on Windows
Once the installation software is finished, you will have a Metrow-
erks  folder installed on your hard disk. Inside will be all the com-
ponents you chose during installation. See the documentation for 
information on what has been installed.
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4
Installing 
CodeWarrior on 
Mac OS
This chapter explains the installation procedure for  the CodeWar-
rior Professional software package on Mac® OS computers. The 
topics in this chapter are:

• Mac OS System Requirements

• Before You Install on Mac OS

• Installation Overview on Mac OS

• Installation Procedure on Mac OS

• What’s Installed on Mac OS

Mac OS System Requirements
Metrowerks CodeWarrior requires the following hardware and 
software setup.

Table 4.1 Mac OS requirements

Hardware PowerPC (recommended) or MC68040 processor, 24 
megabytes of RAM (32 megabytes of RAM recom-
mended), a CD-ROM drive

Software Mac OS System 7.5 or later, 68K-based Mac OS com-
puters require CFM 68K Enabler 4.0 (provided by 
the CodeWarrior installation software for system 
software before Mac OS 8)

Other 120 MB free hard disk space (minimum install)
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Before You Install on Mac OS
Before installing the software on your Mac OS computer, you 
should:

1. Read the Metrowerks Software License.

Make sure you understand and agree with the “Software License” 
on page 65 before installing the software.

2. Make sure your software package is complete.

This software package should contain:

1. QuickStart Professional guide (optional on some products and 
updates)

2. A CodeWarrior Professional Mac OS Tools CD

3. A CodeWarrior Professional Reference CD

4. A registration card (optional on some products and updates)

5. Geekware catalog

NOTE: If any of these items are missing, contact your local dis-
tributor or Metrowerks sales (sales@metrowerks.com ). See 
“Metrowerks Support” on page 57 for more information.

3. Make sure your computer system meets the specified hardware 
and software requirements.

See “Mac OS System Requirements” on page 29.

4. Quit all running applications before installing.

To avoid installation problems, it is highly recommended that you 
quit all running applications before running the Metrowerks soft-
ware installer.

WARNING! Be sure to turn off all virus protection and file shar-
ing software before running the installer.
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Installation Overview on Mac OS
The installation software on the CodeWarrior Professional Mac OS 
Tools CD-ROM installs all the necessary components you need to 
use CodeWarrior. The installation software presents the options 
listed in Table 4.2.

Table 4.2 Installation options for Mac OS

This option… Installs these items on your hard disk

Mac OS Heaven all CodeWarrior development tools, compil-
ers, linkers, libraries, and help files for devel-
oping software for Mac OS

Java Heaven all CodeWarrior development tools, compil-
ers, linkers, libraries, and help files for devel-
oping software for Java™ VM (Virtual Ma-
chine)

Win32/x86 
Heaven

all CodeWarrior development tools, compil-
ers, linkers, libraries, and help files for devel-
oping software for the Microsoft® Win32 API 
running on Intel®-compatible x86 processors

Minimal Install only essential CodeWarrior development 
tools, compilers, linkers, libraries, and help 
files for developing software for Mac OS

other options only the items you choose
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Figure 4.1 Metrowerks installer options

TIP: To get more information about an option, click the  but-
ton to the item’s right. A dialog will appear displaying the option’s 
size and content.

Installation Procedure on Mac OS
To install CodeWarrior Professional on your Mac OS computer:

1. Launch the CodeWarrior installation software.

Insert the CodeWarrior Professional Mac OS Tools CD-ROM into your 
CD-ROM drive and wait for the CD’s icon to appear on the com-
puter’s desktop.

Double-click on the CD’s icon. Then double-click the file named 
CWPro 3 Tools Installer  in the CD’s top folder to launch the 
application and display the welcome screen.

Click Continue to display the software license for CodeWarrior Pro-
fessional.
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2. Read the software license.

If you agree with the license, click Accept to display the release 
notes message.

3. Read the release notes.

When the release notes appear, please read them. Then click Con-
tinue to display the options window.

4. Select a destination for the files.

Choose location to install CodeWarrior on your hard disk using the 
Install Location popup menu (Figure 4.2).

Figure 4.2 Install Location

Choose the Select Folder from the popup menu to install to a spe-
cific folder on the currently selected disk drive. Click Switch Disk 
to choose the next available disk drive.

5. Choose your installation options.

See “Installation Overview on Mac OS” on page 31 for descriptions 
of the installable items. After choosing the components to place on 
your computer, click Install. The CodeWarrior installation process 
may take several minutes.

6. After installation, read the release notes.

If installation software might recommends restarting your com-
puter, do so to make sure any system extensions are properly initial-
ized before using CodeWarrior. Then please read the file “What’s 
New” for the latest release information, and refer to the CW Release  
Notes  folder for additional release details.

7. Install CodeWarrior documentation and examples.

Repeat steps 1 through 6 using the “CWPro 3 Reference Installer” 
application on the CodeWarrior Professional Reference CD to install the 
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CodeWarrior documentation, programming examples, third-party 
books, and other programming goodies.

TIP: Some of the documentation on the Reference CD exists in 
uncompressed format to allow direct viewing on the CD.

8. Install Microsoft Internet Explorer.

Microsoft Internet Explorer (MSIE) is required to fully access the 
CodeWarrior Reference Web Site. Although you may use other Web 
browser applications, you will not be able to take full advantage of 
the Reference Web Site’s features. If you are using a browser other 
than Internet Explorer make sure it is set up to use Adobe Acrobat 
to open PDF files.

If you don’t already have MSIE on your hard disk, launch its instal-
lation software in the Documentation Viewers  folder on the 
CodeWarrior Professional Reference CD.

9. Install Adobe Acrobat.

To read documents in the Reference Web Site, you must have 
Adobe Acrobat Reader installed on your hard disk. If you don’t al-
ready have Acrobat on your hard disk, launch its installation soft-
ware in the Documentation Viewers  folder on the CodeWarrior 
Professional Reference CD.

What’s Installed on Mac OS
Once the installation software is finished, you will have a Metrow-
erks  folder installed on your hard disk. Inside will be all the com-
ponents you chose during installation. See the documentation for 
information on what has been installed.
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A Quick Tour of 
CodeWarrior
This short tour gives new users a glimpse of the CodeWarrior Inte-
grated Development Environment (IDE). The tour is an abridged 
version of the Core Tutorials which comes with CodeWarrior Profes-
sional. For a broader overview of CodeWarrior follow the Core Tuto-
rials.

Guided Tour Overview
The CodeWarrior IDE (Integrated Development Environment) is 
the center of CodeWarrior software development. From the IDE you 
edit, browse, compile, link, debug, and do many other program-
ming tasks.

In this quick tour, you’ll learn to do these tasks while working on an 
example project, gnu_go.mcp :

• Launching the CodeWarrior IDE

• Setting IDE Preferences

• Opening a CodeWarrior Project

• Using the Project Window

• Using the CodeWarrior Editor

• Setting Target Options

• Building Projects with CodeWarrior

• Where to Go From Here
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Launching the CodeWarrior IDE
In this section you learn how simple it is to launch the CodeWarrior 
IDE, thereby opening the gateway to a powerful set of program-
ming tools and beginning your career as a code warrior.

Before you can begin learning about the CodeWarrior IDE, you’ll 
need to launch it.

Windows - Click the Start button in the Task bar, choose Pro-
grams, choose Metrowerks CodeWarrior, then choose the 
CodeWarrior IDE item. The CodeWarrior IDE item will be in a dif-
ferent place in the Start menu if you didn’t use the Start menu de-
fault setting while installing CodeWarrior.

Mac OS- Double-click the CodeWarrior IDE icon in the Metrow-
erks CodeWarrior  folder.

The CodeWarrior IDE application launches, and its menu bar ap-
pears at the top of the screen.

The next section shows you how to customize the IDE.

Setting IDE Preferences
With the CodeWarrior IDE up and running, let’s introduce you to 
the Preferences dialog box. You use the Preferences dialog box to set 
options that apply to all projects you will work with in the 
CodeWarrior IDE.

This section shows you how to do these tasks with the Preferences 
dialog box:

• Opening the Preferences Dialog Box

• Viewing and Setting Options in Preference Panel

• Closing the Preferences Dialog Box

Opening the Preferences Dialog Box

To change a preference, the Preferences dialog box must be open. To 
open the Preferences dialog box choose Preferences from the Edit 
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menu. The Preferences dialog box appears on the screen (Figure 
5.1).

Figure 5.1 The Preferences dialog box

Let’s take a moment to identify some of the items in the Preferences 
dialog box. 

• IDE Preference Panels appears on the left side of the win-
dow. It shows a list of available preference panels. Selecting 
an item in this list displays its corresponding panel on the 
right side of the window.

• Preference Panel view displays the panel selected in the 
Preference Panels list. Changes made in the panel are re-
flected in all new projects you create afterward. 

NOTE: The preference panels are fully discussed in the IDE 
User Guide.
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The Preferences dialog box has three buttons that are always avail-
able to assist you in setting the various preference panel options 
(Figure 5.2).

Figure 5.2 The Preference window’s buttons

These buttons are:

• Factory Settings button resets the current panel to the de-
fault settings. Using Factory Settings only affects the current 
panel’s settings.

• Revert Panel button restores the current panel settings to its 
initial state ,i.e., when the panel was first opened. Click this 
button if, after making changes to a panel’s options, you de-
cide the original settings were just fine.

• Save button commits any changes made in the preference 
panel. Once you’re satisfied with the settings in the panel, 
click Save to commit to the changes. 

Viewing and Setting Options in Preference 
Panel

There are several different preference panels available in the Prefer-
ence Panels list. To set a particular preference, you must choose its 
panel. 

To view a Preference panel, click the panel name in the Preference 
Panel list or use the Up and Down arrow keys to change the selec-
tion. The selected panel name is highlighted in the Preference Panel 
List and the panel appears to the right of the list.

Closing the Preferences Dialog Box

Once you finish setting your global preferences, just close the win-
dow. To close the Preferences dialog box, click the Preference win-
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dow’s close box or choose Close from the File menu. The Prefer-
ences dialog box closes.

Now that you understand the use of the Preferences dialog box, let’s 
explore the process of opening a CodeWarrior project.

Opening a CodeWarrior Project
Open a project file in exactly the same way you open any other file 
from within an application on your computer. In this step you open 
the gnu_go.mcp  project file.

A project is a collection of files and settings that the IDE’s compilers 
and linkers use to create a program or other piece of software.

To open a project choose Open from the File menu to display a file 
dialog box. Then locate and select the gnu_go.mcp project file and 
click Open. This file is in the Source  Examples  folder in the Core  
Tutorials  folder on the CodeWarrior Professional Reference CD.

The IDE opens the project file and displays a Project window.

Now that you have a project open, let’s explore the features of the 
Project window.

Using the Project Window
To effectively use the CodeWarrior IDE, you should be familiar 
with the Project window. The window displays lots of information 
about a project, so identifying and understanding that information 
is our next step. The Project window has these items:

• View Tabs

• Toolbar

• Project Window Columns

• Groups

• Interface Pop-ups

• Context Pop-ups
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View Tabs

The Project window uses view tabs to present different faces of in-
formation in the project. Click a view tab to change the information 
displayed in the Project window.

Figure 5.3 View tabs in the project window

The Project window uses these view tabs:

• Files—enables you to inspect file information in a project. 

• Link Order—enables you to specify the order in which files 
are compiled.

• Targets— enables you configure the targets a project will 
build and the order in which the targets are built.

NOTE: The Link Order view sometimes has a different name. 
For example, when working with Mac OS 68K projects, the Link 
Order view becomes the Segment view.

Toolbar

The Toolbar shows icon buttons that correspond to CodeWarrior 
IDE commands and functions. 

Figure 5.4 The default toolbar in the Project window

The toolbar appears in two formats:
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• Window Toolbar—present in several windows within 
CodeWarrior, including the Project window. An example ap-
pears in Figure 5.4.

• Floating Toolbar—appears as a floating palette that may op-
tionally be anchored under the IDE’s menu bar. 

For information on customizing, hiding, and showing toolbars, see 
the IDE User Guide.

Toolbar Tooltips

Use Tooltips to identify a button in a toolbar. 

Windows To view a Tooltip, position the mouse pointer over the 
button without moving it for a moment.

Mac OS To view a Tooltip, press the Control key and position the 
mouse pointer over a toolbar button.
The Tooltip appears, describing the icon underneath the mouse 
pointer (Figure 5.5).

Figure 5.5 Viewing a Tooltip (on Windows)

Project Window Columns

The columns that appear in the Project window’s File view are listed 
in .
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Table 5.1 Columns in the Project window

Groups

Groups in the File view provide a way to organize project files into 
logical categories to help you keep track of your files. Groups do not 
effect the binary code produced by the compilers.  The only  out-
come is on their organization within the Project window. They can 
be expanded to display their contents, collapsed to hide their con-
tents, rearranged, added, and deleted from a project.

This column… presents this information

 
The Touch column indicates whether a 
file needs to be compiled.

The File column identifies the names of 
files and groups in the project.

The Code column shows the size of the 
compiled executable code.

The Data column shows the size of non-
executable data.

The Debug column indicates whether de-
bugging information will be generated 
for an item.

The Target column indicates whether an 
item is in the project’s current target.

The Checkout Status column indicates 
the current status of an item in a version 
control system. This column only ap-
pears if a version control system is active.

The Link column indicates whether the 
object code generated from an item will 
be linked into the target. This column 
only appears in the Targets view.
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TIP: Groups in the Segment view might have an effect on how 
object code is arranged in your program. For more information, 
consult the Targeting manual for the platform that your program 
will run on.

Interface Pop-ups

Interface Pop-ups reveal additional information about the group or 
files associated with it. The two types of interface pop-ups are:

• Group’s Interface Pop-up—displays a list of all files in that 
group.

• File’s Interface Pop-up—displays a list of interface files re-
quired to compile the file, and allows you to “touch” the file 
which forces it to recompile on the next update or make oper-
ation.

To view an Interface Pop-up click on the pop-up menu to the right 
of the file or group name. The file or group interface pop-up ap-
pears.

Context Pop-ups

The two forms of Context Pop-ups available in the Project window 
include:

• Group Context Pop-up—enables you to check syntax, pre-
process, precompile, compile, disassemble, or remove it from 
the project.

• File Context Pop-up—does everything the Group Context 
Pop-up does as well as showing the File Path, and Reveal in 
Finder the file’s location.

To View a Context Pop-up, position the cursor over a file or group 
name, then click and hold the mouse button down without moving 
the mouse. In a moment the File context pop-up appears.

Now that you have a better understanding of the Project Manager, 
let’s move onto the next section and tour the CodeWarrior IDE’s Ed-
itor.
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Using the CodeWarrior Editor
The CodeWarrior Editor window is where you will spend most of 
your time creating, editing, and navigating through source code for 
your project. This section introduces you to these editing tasks:

• Creating a New Text File

• Opening a File

• Entering Text into a File

• Saving Changes to a File

Creating a New Text File

To create a new text file, just choose New from the File menu. A 
new untitled editor window will appear, ready for you to enter, 
edit, and save text or source code.

Opening a File

There are a variety of ways to open a source code or text file from 
within a project.

Opening a file from the Project window

You can open any editable text file listed in the Project window. In 
this step you open the main.c  file from the gnu_go.mcp  project.

To open the main.c  file in the Project window double-click its 
name in the Project window (Figure 5.6).

Figure 5.6 Opening a file from the Project window

The file opens and appears in its own window.
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TIP: You can also select a file in the Project window using the 
arrow keys and press the Enter/Return key to open it.

Opening a file with a group pop-up

You can also open an editable text file within a group by using the 
group pop-up that appears to the right of the group name. To open 
a file from a pop-up menu select the file from a group pop-up in the 
Project window (Figure 5.7). 

Figure 5.7 Opening a file within a group pop-up

The file opens and appears in its own window.

Opening a file from the File menu

You can use this method to open any text file, whether it is included 
in the project or not. In this step you open the file endgame.c  using 
the File menu.

To open the endgame.c  source code file choose Open from the File 
menu to display a file dialog box. Locate and select the endgame.c  
file, then click Open. The file appears in its own editor window.

Entering Text into a File

Now that you have a file open in the editor, you can enter text or 
source code. The CodeWarrior Editor operates like a regular text ed-
itor, with many special features designed to ease navigation that are 
beyond the scope of this short tour.
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To enter text, position the cursor at the point where you want to in-
sert text, click the mouse button to place the insertion point, then 
begin typing. Your keystrokes appear at the insertion point.

Saving Changes to a File

As you modify your source code files, it’s a good idea to save the 
changes to disk to prevent data loss. To save a file choose Save from 
the File menu. If the file has never been saved before, a file dialog 
box will appear prompting you for a location and a name for the 
file. Click Save when you are done.

The IDE saves the file.

Now that you are comfortable with the IDE’s Editor, it’s time to ex-
plore the Target Settings dialog box.

Setting Target Options
Target settings apply only to the current target of the current 
project. Settings in one project or target in a project do not affect set-
tings in another project or target. The Target Settings dialog box ap-
pears very similar to the Preferences dialog box, with many com-
mon features.

Projects can contain one or more targets. Every target in the project 
has its own unique settings. For example, you can have a debug tar-
get and a production target. You use the Target Settings dialog box 
to set a target’s options.

This section shows you how to do these tasks with the Target Set-
tings dialog box:

• Opening the Target Settings Dialog Box

• Viewing and Setting Options in a Settings Panel

• Closing the Target Settings Dialog Box
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Opening the Target Settings Dialog Box

To change a target option, the Target Settings dialog box must be 
open. In this step you open the Target Settings dialog box.

To open the Target Settings dialog box choose Target Settings from 
the Edit menu. Target will be replaced by the name of the current 
target in the project file. On a PC running Windows for example, the 
targets include: gnu_go  x86 , and go_debug . On the Mac OS the 
targets include: gnu_go  68K, gnu_go PPC , and gnu_go FAT .

 The Target Settings dialog box opens on the screen.

TIP: You can also double-click a target name in the Targets view 
to open the Target Settings dialog box. 

Viewing and Setting Options in a Settings 
Panel

There are several different settings panels available in the Target 
Settings list. To set a particular target option, you must choose its 
panel.

To view a settings panel click the panel name in the Target Settings 
list, or use the Up and Down arrow keys to change the selection. 
The selected settings panel appears to the right of the list.

To learn about setting options in settings panels, consult the Target-
ing manual for the platform that your program will run on.

Closing the Target Settings Dialog Box

Once you finish setting the target options, just close the window. To 
close the Target Settings dialog box click its close box or choose 
Close from the File menu. The Target Settings dialog box closes.

Now that you can set Target Settings for projects, it’s time to build a 
compiled application from the gnu_go.mcp  project.
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Building Projects with CodeWarrior
In this section we’ll introduce you to ways of building a project. 
Among the tasks the IDE provides for compiling, linking, running, 
and debugging your project are:

• Updating a Project

• Making a Project

• Running a Project

• Debugging a Project

• Building a Program

TIP: Before using a command in the Project menu to compile or 
link your project, make sure the IDE will operate on the right target 
by choosing it from the Select Current Target sub-menu in the 
Project menu.

Updating a Project

Use Bring Up To Date on the Project menu to compile all modified 
or “touched” files. This process creates object code for compiled 
files, but does not link the code into a binary file.

Making a Project

Use Make on the Project menu to link a project into a binary file. 
Make only creates binary files on the hard disk, it does not interac-
tively run the final application.

Running a Project

Use Run on the Project menu to launch the application created by 
your project. If the project type is not an application, the Run com-
mand is disabled. Run will update and link the code if necessary.
QSP–48   QuickStart Professional 



A Quick Tour of  CodeWarr ior
Building Projects with CodeWarrior
Debugging a Project

Use Debug on the Project menu to launch the application under 
control of the Debugger. You can then debug your code. Debug will 
also update and link the code if necessary.

Building a Program
In this step you name the output application for the gnu_go.mcp  
project, then compile, link, and run it.

To set the application name

Windows Open the Target Settings dialog box, choose x86 Target 
in the settings panel list, choose Application from the Project Type 
pop-up menu, then enter gnu_go.exe  (without the quotes). Click 
Save when you are done.

Mac OS Open the Target Settings dialog box, choose 68K Target 
in the settings panel list, choose Application from the Project Type 
pop-up menu, then enter  gnu_go (without the quotes). Click Save 
when you are done.

If an alert box appears asking to re-build the project, click OK.

NOTE: The name of Target in the Target Settings dialog box 
changes depending upon the target chosen in the Project window.

To build the gnu_go application

With the project information in place, it is now time to actually 
build the project. In this step you build the gnu_go.mcp  project.

Choose Run from the Project menu. The IDE compiles, links, then 
launches the gnu_go  application. 

Congratulations! You’ve just compiled, linked, and executed an ap-
plication using CodeWarrior.
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Where to Go From Here 
The IDE does many  tasks to make programming easier. However, 
not all features are  covered in this tour. In summary,  the IDE al-
lows you to find and replace text in a single file or in many files, use 
the browser to highlight and navigate through source code objects, 
and debug your program. 

For a guided tour of these powerful tools, read through and do the 
Core Tutorials. 

For detailed information on using these advanced features, see the 
IDE User Guide.

For specific information about developing software for an operating 
system or processor, refer to its corresponding Targeting manual.

For complete information on where to look for more information on 
using CodeWarrior, refer to “Using CodeWarrior” on page 51.
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Using CodeWarrior
This chapter points you to places where you can learn more about 
using CodeWarrior and programming in general, where to find up-
dates and patches to CodeWarrior software, and how to get a list of 
shortcut keyboard controls for the IDE. The topics covered in this 
chapter are:

• Learning How to Use CodeWarrior

• Online Help

• Web Sites of Interest

• Additional Reference Material

• Getting Updates and Patches

• Shortcuts

Learning How to Use CodeWarrior
Metrowerks includes a wealth of online documentation covering all 
aspects of programming with CodeWarrior. Metrowerks documen-
tation files are in the CodeWarrior  Documentation  folder on the 
CodeWarrior Professional Reference CD. 

Table 6.1 Core Documentation

Core Documentation

IDE User Guide Using the CodeWarrior IDE
Debugger User Guide Using the CodeWarrior debugger
CodeWarrior Core Tutorials Step-by-step introduction to IDE compo-

nents
Language/Compiler Documentation

C Compilers Reference Information on the C/C++ compiler front 
end
QuickStart Professional   QSP–51



Using CodeWarr ior
Learning How to Use CodeWarrior
NOTE: Not all of the listed documentation comes with every 
Metrowerks product. See your product’s CodeWarrior Docu-
mentation  folder on the CodeWarrior Professional Reference 
CD-ROM to determine which ones are included in your package.

Pascal Compilers Reference Information on the Pascal compiler front 
end

Error Reference descriptions of compiler and linker error 
messages, with many fixes

Library Documentation

MSL C Reference Reference for the Metrowerks standard C 
library

MSL C++ Reference Reference for the Metrowerks standard 
C++ library

Targeting Manuals

Targeting Win32/x86 Using CodeWarrior to program for 
Win32/x86

Targeting Mac OS Using CodeWarrior to program for 
Mac OS

Targeting Embedded 68K Using CodeWarrior to program for Motor-
ola® Embedded 68K

Targeting MIPS Using CodeWarrior to program for MIPS®
Targeting NetYaroze Using CodeWarrior to program for Net-

Yaroze™
Targeting OS-9 Using CodeWarrior to program for OS-9
Targeting Palm OS Using CodeWarrior to program for Palm 

OS
Targeting PlayStation Using CodeWarrior to program for Play-

Station™
Targeting PowerPC for Embedded Using CodeWarrior to program for Em-

bedded PowerPC™

Core Documentation
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Online Help
Need immediate help? Metrowerks provides you with online assis-
tance through a variety of tools. Table 6.2 below describes the vari-
ous document formats used with online help, and a brief discussion 
of their use.

Table 6.2 Online Help Formats

Check your Metrowerks product documentation to determine 
which online formats it supports.

Web Sites of Interest
Programming tools change fast, and access to the latest information 
about a particular technology or programming environment is vital. 
Below are some of the major Web sites where developer information 
can be obtained:

Format Description

HTML
(Windows, 
Mac OS, 
BeOS)

HTML can be read using your favorite HTML 
browser software. 

PDF
(Windows, 
Mac OS, 
BeOS

PDF is the Adobe Acrobat format. 

WinHelp
(Windows)

Some manuals are available in WinHelp format 
on Windows.
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Table 6.3 Web sites

Additional Reference Material
Learning to program requires additional reference materials. 
Metrowerks includes several wonderful programming books in the 
CodeWarrior Books folder on the CD.  Table 6.4 lists several third-
party books (found in your local bookstore) that can assist you in 
getting up to speed on your programming projects.

Table 6.4 Third party books of interest

For information on 
this target …

See this Web site

Win32/x86 http://www.microsoft.com/msdn

Mac OS http://devworld.apple.com

MIPS http://www.sgi.com/MIPS/

NEC http://www.nec.com/

OS-9 http://www.microware.com/

Palm OS http://palmpilot.3com.com/5024.html

PowerPC Embedded http://www.mot.com/SPS/PowerPC/

Windows CE http://www.microsoft.com/msdn

To learn… Read this book

C New C Primer by Michael Waite and Stephen Prata
Teach Yourself C by Herb Schildt
The C Programming Language, 2nd Edition by B. Kernighan and D. 
Ritchie

C++ C++ Primer Plus, 2nd Edition   by Stephen Prata
Teach Yourself C++ by Herb Schildt
The C++ Programming Language, 2nd Edition  by Bjarne Stroustrup.
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Getting Updates and Patches
Occasionally Metrowerks makes software patches and small up-
dates available through its Web site to enhance or correct bugs in an 
existing CodeWarrior product. You may download these patches 
and apply them to the CodeWarrior software installed on your com-
puter.

For information on the latest patches to CodeWarrior software, 
browse http://www.metrowerks.com .

Shortcuts
To get a list of keyboard shortcuts for the CodeWarrior IDE, see the 
IDE User Guide’s “Configuring IDE Options” chapter. This includes  
a table that lists the default key bindings in the Key Bindings pref-
erence panel.

CodeWarrior Metrowerks CodeWarrior Programming by Dan Parks Sydow
Power Macintosh Programming Starter Kit by Tom Thompson

Pascal Oh, Pascal!, 3rd Edition by D. Cooper & M. Clancy

Win32/x86 Advanced Windows® by Jeffrey Richter
Programming Windows® 95 by Arnold Petzold

Mac OS Macintosh Programming Techniques by Dan Parks Sydow
Macintosh C Programming Primer, Volume 1 by D. Mark & C. Reed
Programming Starter Kit for Macintosh   by Jim Trudeau
Ultimate Macintosh Programming  by Dave Mark

To learn… Read this book
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Metrowerks Support
This chapter describes ways to contact Metrowerks with your ques-
tions on registration, site licensing, sales, and technical support. 

The sections in this chapter are:

• Contacting Metrowerks

• Registration and Updates

• Technical Support

• Sales, Renewals, and Site Licensing

• Worldwide Distributors

• Metrowerks Store

Contacting Metrowerks
Use the information shown in Table 7.1 to contact Metrowerks.

Table 7.1 Contacting Metrowerks

Registration and Updates
If this is the first time you’ve purchased CodeWarrior Professional, 
fill out and mail the registration card. After you register, you will 
have access to free Metrowerks CodeWarrior technical support and 

USA Metrowerks Corporation
Department 334
P.O. Box 9700
Austin, TX 78766-9700
U.S.A.
tel: (512) 873-4700
fax: (512) 873-4900 
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Technical Support
become eligible for free updates (if your product qualifies for up-
dates). 

To register your Metrowerks product, or, if you have questions on 
your registration, contact Metrowerks using the information in 
Table 7.2.

Table 7.2 Registration support

Technical Support
If you are having problems installing or using a Metrowerks prod-
uct, contact Metrowerks Technical Support. Metrowerks offers tech-
nical support free of charge to registered users; however, you pay 
for toll charges and online service fees.

Table 7.3 Technical support

NOTE: To assist Technical Support in answering your question, 
please use the email Report Forms  folder found in the Re-
lease Notes  folder when submitting a support question.

Internet WWW: http://www.metrowerks.com
To register: register@metrowerks.com
Questions: reg-questions@metrowerks.com

Mail Metrowerks Corporation
Dept. 334
P.O. Box 9700
Austin, TX 78766-9700
U.S.A.
fax: (512) 873-4901

World Wide Web http://www.metrowerks.com

email support@metrowerks.com

newsgroup comp.sys.mac.programmer.codewarrior

Compuserve Goto: Metrowerks
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Sales, Renewals, and Site Licensing
For information on a site license or buying a new Metrowerks prod-
uct at a reduced price (with free updates, if applicable), for the 
U.S.A. and Canada, contact Metrowerks 

Table 7.4 US and Canada distributors.
 

Worldwide Distributors
If you live outside the U.S.A. or Canada, use Table 7.5 to contact the 
distributor in your area for customer support, upgrades, renewals, 
site licensing, and sales.

NOTE: Some distributors don’t sell or support CodeWarrior em-
bedded system products. Contact the distributor nearest you for 
information on the CodeWarrior products that company sells.

Internet WWW: www.metrowerks.com
Sales: sales@metrowerks.com
Academic licensing: academia@metrowerks.com

Mail Metrowerks Corporation 
Dept. 334
P.O. Box 9700
Austin, TX 78766-9700
U.S.A.
fax: (512)873-4901
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Table 7.5 Worldwide distributors.

Australia & New Zealand
Techflow Pty Ltd
5/17 Mooramba Road 
Dee Why, NSW 2099, Australia
tel: +612 9971 4311
fax: +612 9982 3623
e-mail: sales@techflow.com.au  
WWW: www.techflow.com.au

Austria
Software-Schmiede GmbH.
Huetteldorfor Str. 6/9
A-1150 Vienna
Austria
tel: +43 (1) 983 36 83
fax: +43 (1) 983 36 83-9
e-mail: mm@sw-schmiede.co.at , 
brains@brains.at

Brazil
CAD Technology 
Rue Helena 218 cj. 80
Sao Paulo SP
Brazil
tel: +55 11 829 8257
fax: +55 11 820 4485
e-mail: cadtech@macbbs.com.br
WWW: www.macbbs.com.br/cadtech

Denmark
SSA Tradings
Laplandsgade
2300 Copenhagen S
Denmark
tel: +45 32 96 2666
fax: +45 32 96 2300
e-mail: kim@ssa.dk

France & Belgium
AWARE
1, rue du Dahoney 
75011 Paris
France
Serveur First Class: 01 43 56 97 10
tel: +33 1 43 56 57 58
fax: +33 1 43 56 66 77
e-mail: gmasson@aware.fr
WWW: www.aware.fr  

France (CodeWarrior for Palm OS only))
Intervalle
159 Avenue Gallieni 
93170 Bagnolet
France
tel: +49 72 58 58
fax: +49 72 58 59
e-mail: giles.pommier@intervalle.fr

Germany (embedded products only)
ARS Software GmbH
Starnberger Str. 22
D-82131 Gauting/Munich
tel: +49 89/89 34 13 0
fax: +49 89/89/34 13 10
e-mail: info@ars.m.isar.de
WWW: www.ars2000.com

Germany
Promo GmbH
Promo Datentechnik+Systemberatung GmbH 
Eduarstrasse 46-48
D-20257 Hamburg
Germany
tel: +49 40 85 17 44-0
fax: +49 40 85 17 44 44
e-mail: oliverk@promo.de  
WWW: www.promo.de  
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Germany (Windows® products only)
Softline GmbH 
Appenweierer Strasse 45
D-77704 Oberkirch
Germany
tel: +49 78 02 92 46 00
fax: +49 78 02 92 42 40
e-mail: softinfo@softline.de

Hong Kong
G & B Computerware Dist. Ltd. 
Unit A3 5/F Jing Hin Industrial Building
5 Wang Kee Street 
Kowloon Bay
Hong Kong
tel: +852 26617181
fax: +852 26614679
e-mail: gregoryr@hk.super.net  

Hungary
BertDolf BT
Keszkens u. 15. IV/9
H-1131 Budapest
Hungary
tel/fax: 361/330-5038
e-mail: bertdolf@starkingnet.hu  

Iceland
Skúli Valberg Ólafsson
EJS
Grensásvegi 10
IS-108 Reykjavík
Iceland
tel: +354 563 3000
fax: +354 568-8487
e-mail: skuli@ejs.is
ymin@ejs.is
sidar@ejs.is

Israel
Kalanit Ltd.
Doron Dreyer 
16 Homa Umigdal St
Tel-Aviv 67771
Israel
fax: 972 3 5372928
e-mail: dreyer@kalanit.co.il

Italy
Essai Srl. 
c/o Apple Computer Spa
Via Lanino 5
20144 Milano
Italy
tel: +39 477891
fax: +39 47789250
e-mail: metrowerks@essai.it

Italy (for embedded products only)
Veratim 
Luca Lugari
13900 Biella
Italy
tel: +39 15-2522636
fax: +39 15-2521259
e-mail: lugari@biella.alpcom.it

Japan
B.U.G. Inc.
Tanaka Bldg., 1F, 1-1-36
Kiyoto 1-jyo, Toyohira-ku
Sapporo, 004
Japan
tel: +81 3 3486 6710
fax: +81 3 3486 6702
e-mail: cw-register@bug.co.jp
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Japan
Metrowerks Co., Ltd. 
World Udagawa Bldg. 8F 
Udagawa-cho 36-6, Shibuya-ku
Tokyo, 150
Japan
tel: +8133 780 6091
fax: +8133 780 6092
e-mail: j-info@metrowerks.com
WWW: www.metrowerks.com

Norway (for embedded products only)
AD Elektronikk AS
P.O. Box 104
N-1405 Langhus
Norway
tel: +47 64 86 99 70
fax: +47 64 86 99 20

Poland
Programac 
l. Chmielna 5/7,
00-021 Warszawa,
Poland
tel/fax: +48 228 269 291
e-mail: metrowerks@programac.com.pl  

Russia
DPI Co.
39, Nizhnaya Krasnolelskaya St.
Moscow 107066
Russia
tel: +7(095)956 3974
fax: +7 (095) 264-2946

Singapore
DOML International Pte. Ltd. 
100 Eu Tong Sen Street 
#04-15 Pearl’s Centre
Singapore 059812
Republic of Singapore
tel: +65 227 5455
fax: +65 224 0279

Sweden
Studentlitteratur AB 
Åkergränden 1 
221 00 Lund
Sweden
tel: +46 46 31 22 22
fax: +46 46 30 53 39
e-mail: 
reine.lundgren@studentlitteratur.se  
WWW: www.studli.se

Sweden (CodeWarrior for Palm OS only)
Datanat AB 
P.O.Box 532 
184 25 Akersberga
Sweden 445 43 80-9
tel: +46 08 544 106 00
fax: +46 08 544 106 44

Switzerland
Innoware AG
Stationsstrasse 53
Postfach
CH-8603 Schwerzenbach (in Zurich)
Switzerland
tel: +41 1 908 44 00
fax: +41 1 908 44 10
E-mail: bvetter@innoware.ch
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Metrowerks Store
Visit the online locations in Table 7.6 to view the Metrowerks Store 
catalog.

Table 7.6 Online Geekware catalogs

To purchase an item directly from Metrowerks, use the following 
numbers.

Table 7.7 Catalog sales

South Korea
Elex Computer 
Elex Bldg. 
40-17 Hangangro 3-ga
Yongsan-ku
Dept. Developer Support
Seoul, Korea 140-013
tel: +82 2709 8317
fax: +82 2709 8453
e-mail: it0103@applelink.apple.com  

Taiwan
Photin (Attn: Jolios Lin, Prod. Mgr.)
FL. 8-1, No. 174, FU-HSIN N. Rd.
Taipei
Taiwan R.O. C.
tel: +886 2 545 5216
fax: +886 2 514 0377
e-mail: jolios@email.photin.com.tw

Ukraine
Software MacKiev
65 Peremohy Pr.
Kyiv, Ukraine, 254062
tel: +380 44 442 9295
fax: +380 44 443 1201
e-mail: macukraine@aol.com

UK, & Ireland
Full Moon Software 
PO Box 862
Maidenhead 
Berks, SL6 0QJ 
United Kingdom
tel: +44 1628 660242
fax: +44 1628 666084
e-mail: sales@fullmoon.com  
WWW: www.fullmoon.com

WWW URL: http://www.metrowerks.com

Compuserve Goto: Metrowerks

Telephone tel: (800) 377-5416
fax: (512) 873-4901
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Software License
PLEASE READ THIS LICENSE CAREFULLY BEFORE USING THE SOFTWARE. BY 
USING THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF 
THIS LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, 
PROMPTLY RETURN THE UNUSED SOFTWARE TO THE PLACE WHERE YOU OB-
TAINED IT AND YOUR MONEY WILL BE REFUNDED.

1. License. The application, demonstration, system and other software accompanying this 
License, whether on disk, in read only memory, or on any other media (the “Software”), 
the related documentation and fonts are licensed to you by Metrowerks and its Licensors. 
You own the disk on which the Software and fonts are recorded but Metrowerks and/or 
Metrowerks' licensors retain title to the Software, related documentation and fonts. This Li-
cense allows you to use the Software and fonts on a single computer. You may use a copy 
of the software on a home or portable computer, as long as the extra copy is never loaded 
at the same time the software is loaded on the primary computer on which you use the 
Software. You may make one copy of the Software and fonts in machine-readable form for 
backup purposes. You must reproduce on such copy the Metrowerks copyright notice and 
any other proprietary legends that were on the original copy of the Software and fonts. 
You may also transfer all your license rights in the Software and fonts, the backup copy of 
the Software and fonts, the related documentation and a copy of this License to another 
party, provided the other party reads and agrees to accept the terms and conditions of this 
License.

2. Restrictions. The Software contains copyrighted material, trade secrets, and other pro-
prietary material. In order to protect them, and except as permitted by applicable legisla-
tion, you may not decompile, reverse engineer, disassemble or otherwise reduce the Soft-
ware to a human-perceivable form. You may not modify, rent, lease, loan, distribute or 
create derivative works based upon the Software in whole or in part. If the Software was li-
censed to you for academic use, you may not use the Software for commercial product de-
velopment. You may use the Software to develop freeware or shareware.

3. Software Redistribution. Appendix A hereunder contains specific information concern-
ing software redistribution of different binaries licensed to you under this software license 
agreement.

In all cases of software redistribution and in order to protect Metrowerks and Metrowerks' 
Licensors intellectual property rights in the Software and redistributable libraries herein, 
you must reproduce on each copy a copyright notice that clearly states 

“Copyright by [Licensee Name] and its Licensors,”

and distribute such Software and redistributable libraries pursuant to a valid agreement 
that is at least as protective of Metrowerks and Metrowerks' Licensors rights in the Soft-
ware and redistributable libraries as this License.

4. Termination. This License is effective until terminated. You may terminate this License 
at any time by destroying the Software, related documentation and fonts and all copies 
thereof. This License will terminate immediately without notice from Metrowerks if you 
QuickStart Professional   QSP–65



Software License
fail to comply with any provision of this License. Upon termination you must destroy the 
Software, related documentation and fonts and all copies thereof.

5. Export Law Assurances. You agree and certify that neither the Software nor any other 
technical data received from Metrowerks, nor the direct product thereof, will be exported 
outside the United States except as authorized and as permitted by the laws and regula-
tions of the United States. If the Software has been rightfully obtained by you outside of the 
United States, you agree that you will not re-export the Software nor any other technical 
data received from Metrowerks, nor the direct product thereof, except as permitted by the 
laws and regulations of the United States and the laws and regulations of the jurisdiction 
in which you obtained the Software.

6. Government End Users. If you are acquiring the Software and fonts on behalf of any 
unit or agency of the United States Government, the following provisions apply. The Gov-
ernment agrees that the Software and fonts shall be classified as “commercial computer 
software” as that term is defined in the applicable provisions of the Federal Acquisition 
Regulation (“FAR”) and supplements thereto, including the Department of Defense 
(“DoD”) FAR Supplement (“DFARS”). If the Software and fonts are supplied for use by 
DoD, it is delivered subject to the terms of this Agreement and either (i) in accordance with 
DFARS 227.7202-1(a) and 227.7202-3(a), or (ii) with restricted rights in accordance with 
DFARS 252.227-7013(c)(1)(ii) (OCT 1988), as applicable. If the Software and fonts are sup-
plied for use by any other Federal agency, it is restricted computer software delivered sub-
ject to the terms of this Agreement and (i) FAR 12.212(a); (ii) FAR 52.227-19; or (iii) FAR 
52.227-14(ALT III), as applicable.

7. Limited Warranty on Media. Metrowerks warrants the compact disc on which the Soft-
ware and fonts are recorded to be free from defects in materials and workmanship under 
normal use for a period of ninety (90) days from the date of purchase as evidenced by a 
copy of the receipt. Metrowerks entire liability and your exclusive remedy will be replace-
ment of the diskettes and/or compact disc not meeting Metrowerks limited warranty and 
which is returned to Metrowerks with a copy of the receipt. Metrowerks will have no re-
sponsibility to replace a disk/disc damaged by accident, abuse or misapplication. ANY 
IMPLIED WARRANTIES ON THE COMPACT DISC, INCLUDING THE IMPLIED WAR-
RANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF DELIVERY. 
THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO 
HAVE OTHER RIGHTS WHICH VARY BY JURISDICTION.

8. Disclaimer of Warranty on Metrowerks Software. You expressly acknowledge and 
agree that use of the Software and fonts is at your sole risk. Except as is stated above, the 
Software, any applications created with the Software, related documentation and fonts 
are provided “AS IS” and without warranty of any kind and Metrowerks and Metrow-
erks' Licensor(s) (for the purposes of provisions 7 and 8, Metrowerks and Metrowerks' 
Licensor(s) shall be collectively referred to as “Metrowerks”) EXPRESSLY DISCLAIM 
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIM-
ITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. METROWERKS DOES NOT 
WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET 
YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE 
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE AND 
THE FONTS WILL BE CORRECTED. FURTHERMORE, METROWERKS DOES NOT 
WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE 
RESULTS OF THE USE OF THE SOFTWARE AND FONTS OR RELATED DOCU-
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MENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, 
OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY 
METROWERKS OR A METROWERKS AUTHORIZED REPRESENTATIVE SHALL 
CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WAR-
RANTY. WITHOUT LIMITING THE FOREGOING, METROWERKS DISCLAIMS 
ANY AND ALL EXPRESS OR IMPLIED WARRANTIES OF ANY KIND, AND YOU 
EXPRESSLY ASSUME ALL LIABILITIES AND RISKS, FOR USE OR OPERATION OF 
ANY APPLICATION PROGRAMS YOU MAY CREATE WITH THE SOFTWARE, IN-
CLUDING WITHOUT LIMITATION, APPLICATIONS DESIGNED OR INTENDED 
FOR MISSION CRITICAL APPLICATIONS, SUCH AS PACEMAKERS, WEAPONRY, 
AIRCRAFT NAVIGATION, FACTORY CONTROL SYSTEMS, ETC.” SHOULD THE 
SOFTWARE PROVE DEFECTIVE, YOU (AND NOT METROWERKS OR A METROW-
ERKS AUTHORIZED REPRESENTATIVE) ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS DO 
NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EX-
CLUSION MAY NOT APPLY TO YOU.

9. Limitation of Liability. UNDER NO CIRCUMSTANCES INCLUDING NEGLIGENCE, 
SHALL METROWERKS BE LIABLE FOR ANY INCIDENTAL, SPECIAL OR CONSE-
QUENTIAL DAMAGES THAT RESULT FROM THE USE OR INABILITY TO USE THE 
SOFTWARE OR RELATED DOCUMENTATION, EVEN IF METROWERKS OR A 
METROWERKS AUTHORIZED REPRESENTATIVE HAS BEEN ADVISED OF THE POS-
SIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE LIMITA-
TION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAM-
AGES SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

In no event shall Metrowerks' total liability to you for all damages, losses, and causes of ac-
tion (whether in contract, tort (including negligence) or otherwise) exceed that portion of 
the amount paid by you which is fairly attributable to the Software and fonts.

10. Controlling Law and Severability. This License shall be governed by and construed in 
accordance with the laws of the United States and the State of California, as applied to 
agreements entered into and to be performed entirely within California between California 
residents. If for any reason a court of competent jurisdiction finds any provision of this Li-
cense, or portion thereof, to be unenforceable, that provision of the License shall be en-
forced to the maximum extent permissible so as to effect the intent of the parties, and the 
remainder of this License shall continue in full force and effect.

11. Complete Agreement. This License constitutes the entire agreement between the par-
ties with respect to the use of the Software, the related documentation and fonts, and su-
persedes all prior or contemporaneous understandings or agreements, written or oral, re-
garding such subject matter. No amendment to or modification of this License will be 
binding unless in writing and signed by a duly authorized representative of Metrowerks.
Should you have any questions or comments concerning this license, please do not hesitate 
to write to Metrowerks Corp., P.O. Box 334, Austin, TX 78758, USA. Attn: Warranty Infor-
mation.

Appendix A - Software Redistribution Information for CodeWarrior SDK

In all cases of software redistribution and in order to protect Metrowerks and Metrowerks' 
Licensors intellectual property rights in the Software and redistributable libraries herein, 
you must reproduce on each copy a copyright notice that clearly states 

“Copyright by [Licensee Name] and its Licensors,”
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and distribute such Software and redistributable libraries pursuant to a valid agreement 
that is at least as protective of Metrowerks and Metrowerks' Licensors rights in the Soft-
ware and redistributable libraries as this License. Without limiting the foregoing, in no 
event shall licensee attempt to expand Metrowerks' warranty or other obligations for the 
Software and redistributable libraries beyond that set forth in this agreement.

The following list describes the Software and redistributable libraries that licensees here-
under may incorporate into their own programs and distribute (only in object code form) 
only in conjunction with and as part of their own programs, pursuant to the terms of this 
Software License in the event the Software and redistributable libraries listed hereunder 
are distributed by Metrowerks to the licensee as part of the current CodeWarrior CD-ROM.

These files in object code form only and bundled with Licensee software only, can be dis-
tributed by Licensee to end users directly or indirectly through dealers, distributors, VARs, 
OEMs and other relicensors.

Metrowerks Software and Redistributable Libraries

*The PowerPlant Library and sample code in object code form

 *The Metrowerks Standard Library and sample code in object code form

*The Latitude Library and sample code in object code form

Note: Licensees may not distribute the source code of the PowerPlant Library, Metrowerks 
Standard Library, Latitude Library any derivative thereof, or sample code thereto, without 
express written permission from an authorized officer of Metrowerks Corp.

 The Java VM and associated runtime libraries contained in the RedistributableVM.sit ar-
chive found in the Java support folder.

Apple Computer Software and Redistributable Libraries 

Object-code derivations of sample code and final versions of the following files:

* AppleScript runtime files (AppleScript, Inline Filter, AppleScriptLib, ObjectSupportLib, 
Beep, Choose Application, Choose File, Current Date, Display Dialog, File Commands, 
Load Script, New File, Numerics, Read/Write Commands, Run Script, Scripting Compo-
nents, Store Script, String Commands, Time to GMT, English Dialect).

* XTND runtime files (Claris XTND System, contents of Claris Translators folder, XTND-
InterfaceLib.o, XTNDInterfaceLib.o, XTND Power Enabler). 

* MacODBC runtime files (ODBC Configuration Manager, ODBC Setup, ODBC Driver 
Manager).

* Serial Switch

* Thread Manager

* Sound and Sound Manager

* File System Manager

* Macintosh Drag and Drop, Clipping Extension, and Dragging Enabler, provided that the 
Licensee includes in a conspicuous place on the exterior of the packaging of the licensee 
programs, the following language: “Macintosh Drag and Drop included”.

* MacApp provided that the Licensee includes in a conspicuous place on the exterior of the 
packaging of the licensee programs, the following language: “Macintosh Drag and Drop 
included”.
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* Apple Shared Library Manager files: Shared Library Manager and ASLM Resources

* AppleSearch Client, AppleSearch Authentication, AppleSearch Communication, and AS-
ClientLib.o.

* Apple Guide

* UGLibrary.o (Appleshare API glue)

* Apple MIDI Driver and MIDI Manager

* Mathlib

* Telephone Manager and TelMgrGlue.o

* The following Communications Toolbox files: CTB Resources, CommToolboxExten-
sions.o, Apple Modem Tool, Text Tool, AppleTalk ADSP Tool, TTY Tool, XMODEM Tool, 
VT102 Tool, SerialTool, TTYFont, VT102Font, ADSP, AdminLAT, LAT, LAT Prep, and 
LAT Tool

* The following MacSNMP, MacTCP, and MacX25 files: SNMPLibrary.cln.o, SNMPLi-
brary.clf.o, LibraryManager.n.o, LibraryManager.o, LAP802.a.o, LAP802.c.o, 
LAP802Arp.c.o, LAP802Mdev.c.o, LAPAsmUtil.a.o, LAPloopBack.a.o, FSDES.o, IPC-
Glue.o, X25_Interface_Library.o

* The following Network Software Installer files: Apple Token Ring NB, AppleTalk, Ether-
Talk Phase 2, Network, Responder, Token Ring, TokenTalk Phase 2, and TokenTalk Prep

* The following MacTCP-related HyperCard XCMDs (built from the sample source code in 
the HyperCard MacTCP Toolkit folder): TCPActiveOpen, TCPCharsAvailable, TCPClose, 
TCPNameToAddr, TCPOverview, TCPPassiveOpen, TCPRecvChars, TCPRecvMsg, 
TCPRecvUpTo, TCPRelease, TCPSend, TCPState, and TCPVersion

For any additional information on Apple-licensed software contact Apple's Software Li-
censing Department at the following address for further information:

Software Licensing Department Apple Computer, Inc. 2420 Ridgepoint Drive, MS: 198-
SWL, Austin, TX, 78754 Telephone: 512/919-2645 AppleLink: SW.LICENSE

Motorola Software and Redistributable Libraries

* The following LibMoto files: atan.o, fatan.o, fpow.o, fsqrt.o, ftrig.o, memmove.o, pow.o, 
sqrt.o, strcmp.o, strlen.o, stncmp.o, trig.o, in both statically linkable and dynamically link-
able object code formats for all PowerPC based operating systems for which Motorola pro-
vides a version of LibMoto.

See the Microsoft License agreement on the CodeWarrior CD-ROM for information on re-
distributable libraries and documents.

Other Third Party Libraries 

Licensee may not distribute other third party libraries contained in the CodeWarrior CD-
ROM, unless specific license terms that may accompany such libraries expressly authorize 
the licensee to distribute them to the customers of the licensee. In the event the licensee dis-
tribute such third party libraries based upon express authorization, the licensee must ad-
here strictly to the specific terms of such third party licensee. 

For any additional information on Metrowerks-licensed software write or email to: 
Metrowerks Corp., P.O. Box 334, Austin, TX, 78758, USA. attn: Warranty Information. 
email: support@metrowerks.com 
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Guide to CodeWarrior Documentation
CodeWarrior  documentation is modular, like the underlying tools. There are manuals 
for the core tools, languages, libraries, and targets. The exact documentation provided 
with any CodeWarrior product is tailored to the tools included with the product. Your 
product will not have every manual listed here. However, you will probably have addi-
tional manuals (not listed here) for utilities or other software specific to your product.

Core Documentation

IDE User Guide How to use the CodeWarrior IDE

Debugger User Guide How to use the CodeWarrior debugger

CodeWarrior Core Tutorials Step-by-step introduction to IDE components

Language/Compiler Documentation

C Compilers Reference Information on the C/C++ front-end compiler 

Pascal Compilers Reference Information on the Pascal front-end compiler

Error Reference Comprehensive list of compiler/linker error messages, with many fixes

Pascal Language Reference The Metrowerks implementation of ANS Pascal

Assembler Guide Stand-alone assembler syntax

Command-Line Tools Reference Command-line options for Mac OS and Be compilers

Plugin API Manual The CodeWarrior plugin compiler/linker API

Library Documentation

MSL C Reference Function reference for the Metrowerks ANSI standard C library

MSL C++ Reference Function reference for the Metrowerks ANSI standard C++ library

Pascal Library Reference Function reference for the Metrowerks ANS Pascal library

MFC Reference Reference for the Microsoft Foundation Classes for Win32

Win32 SDK Reference Microsoft’s Reference for the Win32 API

The PowerPlant Book Introductory guide to the Metrowerks application framework for Mac OS

PowerPlant Advanced Topics Advanced topics in PowerPlant programming for Mac OS

Targeting Manuals

Targeting BeOS How to use CodeWarrior to program for BeOS

Targeting Java VM How to use CodeWarrior to program for the Java Virtual Machine

Targeting Mac OS How to use CodeWarrior to program for Mac OS

Targeting MIPS How to use CodeWarrior to program for MIPS embedded processors

Targeting NEC V810/830 How to use CodeWarrior to program for NEC V810/830 processors

Targeting Net Yaroze How to use CodeWarrior to program for Net Yaroze game console

Targeting Nucleus How to use CodeWarrior to program for the Nucleus RTOS

Targeting OS-9 How to use CodeWarrior to program for the OS-9 RTOS

Targeting Palm OS How to use CodeWarrior to program for PalmPilot

Targeting PlayStation OS How to use CodeWarrior to program for the PlayStation game console

Targeting PowerPC Embedded Systems How to use CodeWarrior to program for PPC embedded processors

Targeting VxWorks How to use CodeWarrior to program for the VxWorks RTOS

Targeting Win32 How to use CodeWarrior to program for Windows
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